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Budget Planner for Windows Help - Topics

New features - Windows version vs. DOS version

Menus

      File group
      Help group

Printing

      Print menu option
      Printing from the Maintenance window

How to register your Shareware program



New Features - Windows version vs. DOS version

Budget Planner for Windows has evolved considerably from its DOS predecessor.
This is a comparison of Budget Planner for Windows to Budget Planner for DOS.

Win - The ability to name your own files and save them in any directory
DOS - Used one database file with a fixed name in the software's directory

Win - Scrollable item/amount lists capable of holding 30 entries
DOS - Individual item/amount fields holding one entry

Win - All file maintenance functions in one window (add, print, etc.)
DOS - Individual maintenance function selection from pull-down menus

Win - "Stereo" browse buttons can display your saved information instantly
DOS - Browse required locating a record before displaying

Win - More intuitive maintenance process (add, change, delete)
DOS - Confusing "press Enter from Amount field" update process

Win - "Safety" temporary disabling (gray-out) of non-related menu items
DOS - No comparable function

Win - Selection of any printer driver set up in your Windows configuration
DOS - Uses hardware ports for directing output

Win - Printer Setup for configuring your Windows printer driver options
DOS - No comparable function

Win - Using Windows' Print Manager you can continue working while you print
DOS - Program was bound until printing completed 

Win - More flexible printing options (full file, range of records)
DOS - Only printed individual records

Win - Advanced help file with index and topics sections
DOS - Pull-down menu help



FILE Menu Group

The File menu group contains the following options:

      New -- Open new budget database file
      Open -- Open existing budget database file
      Close -- Close existing budget database file
      Maintenance -- File activity (add, print, etc.)
      Print -- Print options
      Print Setup -- Set print driver options
      Exit -- End and return to Windows

When you first enter the program, the Close, Maintenance, and Print options
are grayed because those functions are not used until a database file is opened.

Once a database is opened, the New, Open, and Exit options are grayed 
because they are not to be used when a file is open.



HELP Menu Group

The Help menu group contains the following options:

      Topics... -- Help file topics
      Index -- Help file index
      About Budget Planner for Windows -- Title/version/author window

To select one of these items, click the Help menu and click the item of
your choice.



NEW Menu Item

Select this menu option to create a new (empty) budget database file.    

All Budget Planner for Windows database files have a .CRD extension.    

Select the directory to save your file in by clicking in the Directories box.    
If the directory contains other .CRD files they will be shown in gray in the 
file name box.    SELECTING A GRAYED FILE DESTROYS THE ORIGINAL
AND CREATES A NEW EMPTY FILE IN ITS PLACE.

You may select a different drive by clicking the Drives box.

Click the Ok button to create the new file or Cancel to abort the process.

If the file open was successful, a message window will be displayed stating
the file is open.



OPEN Menu Item

Select this menu option to open an existing budget database file.    

All Budget Planner for Windows database files have a .CRD extension.    

Select the directory to open your file from by clicking in the Directories box.    

All other .CRD files will be shown in the file name box.    You may type the 
name of the file to be opened and click the Ok button or double-click on the 
file of your choice.

You may select a different drive by clicking the Drives box.

Click the Ok button to open the new file or Cancel to abort the process.

If the file open was successful, a message window will be displayed stating
the file is open.



CLOSE Menu Item

Select this menu option when you are finished with an open database file.    If
the file close is successful, a message window will be displayed stating the
file was closed.

Alternately, you may double-click the main window close box to exit the program
and automatically close the open file without displaying the close message.



MAINTENANCE Menu Item

The Maintenance window is the "nerve center" of Budget Planner for Windows.
The following functions are performed from the Maintenance window:

      Add -- Insert new record into file
      Change -- Modify contents of an existing record
      Delete -- Remove an existing record
      Totals -- Calculate budget statistics
      Clear -- Erase the window entry field contents
      Print -- Print a file record
      Help -- Access the help file
      Exit -- Close the Maintenance window
      First file record ("I<") -- Display first record in a file
      Previous file record ("<") -- Display the previous record from current
      Find file record ("I?I") -- Locate a specific record in a file
      Next file record (">") -- Display the next record from current
      Last file record (">I") -- Display the last record in a file



PRINT Menu Item

Budget Planner for Windows offers two methods of printing:

      Print menu option (available in the registered version of BPW)
      Printing from the Maintenance window



PRINT SETUP Menu Item

This menu option opens a Windows' Print Setup box to allow you to configure your
print settings.



EXIT Menu Item

Clicking the Exit menu option ends the program and returns you to Windows.



TOPICS... Menu Item

Clicking the Topics... menu option opens the help file and displays the help
topics article.



INDEX Menu Item

Clicking the Index menu option opens the help file and displays the help index.



ABOUT BUDGET PLANNER FOR WINDOWS Menu Item

Clicking this menu option displays the information window for Budget Planner for 
Windows.    It contains the following information:

      Program Title
      Program Version
      Author
      Copyright Year

This window is provided for information purposes.



Add Record (Maintenance)

To add a record into a budget database file:

First, from the Maintenance window, click the Add button.    A message will prompt
you to fill in the entry fields.    The date and time are filled in and are not 
editable in add mode.    You can only modify the date and time in change mode.

Second, fill in the Description, Budget Amount, Item, and Amount fields.    The 
Item and Amount fields are scrollable lists which may hold up to 30 entries.
NOTE: only Item/Amount entries greater than $0.00 will be calculated in the
Totals fields.    If the Description and/or Budget Amount fields are not filled 
in, a message prompts you to do so.

Third, after entering information in the entry fields, click Add again.    A 
message will be displayed showing the record was added to the file and if you 
wish to repeat the process to click the Add button again.

To abort the add process at any time, click the Clear button.



Change Record (Maintenance)

To change the contents of a budget database record:

First, from the Maintenance window, locate the record you wish to modify.    Use
the browse buttons ("I<" "<" "I?I" ">" ">I") to display the record's contents in 
the entry fields.

Second, modify any entry field -- Date, Time, Description, Budget Amount, Item,
and/or Amount.    If you change the Budget Amount and/or any Amount list item,
click the Totals button to recalculate the statistics values.

Third, click the Change button.    A message informs you that your changes were
successfully saved.

To abort the change process at any time, click the Clear button.



Delete Record (Maintenance)

To delete a budget database record:

First, from the Maintenance window, locate the record you wish to modify.    Use
the browse buttons ("I<" "<" "I?I" ">" ">I") to display the record's contents in 
the entry fields.

Second, click the Delete button.    A confirmation message asks if you are sure this
is the record you want to delete.    Click the Yes button to delete the record or the
NO button to abort the delete.    If you click the Yes button the deletion is
immediate and irreversable.    The only ways to recover a deleted record is to
add the record again or restore the database file from a backup.

To abort the delete process, click the NO button and then the Clear button.



Totals (Maintenance)

The Totals button calculates the budget statistics of the current record.
The budget statistics are:

      Total Items
      Total (budget items) Amount
      Difference (from budget amount)
      Percentage (of budget amount)

When adding, changing, or deleting a database record, the budget statistics are
updated by clicking the Totals button.



Clear (Maintenance)

The Clear button erases all values from the entry and statistics fields
and resets the add process to its beginning.



Print Record (Maintenance)

To print your budget database record, click the Print button.    A standard
print box will be opened.    Choose your printer and click the Ok button to
print.    If you are using Windows' Print Manager, the print job will be spooled 
to the selected printer.

Since the Item and Amount lists can hold up to 30 entries, the lists are printed
to the length of the last Amount item greater than $0.00.

To abort the print process, press the Cancel button in the print box.

Creating a printable ASCII file of a database record



Help (Maintenance)

Clicking the Help button opens the help file and displays the Maintenance
help article.



Exit (Maintenance)

Clicking the Exit button closes the Maintenance window and returns you
to the main window.



First Record (Maintenance)

Clicking the First Record ("I<") button displays the first record of the
database file.    File records are sorted in descending order from most recent
to least recent by date, time, and description.

To clear the display, click the Clear button.



Previous Record (Maintenance)

Clicking the Previous Record ("<") button displays the previous record from the 
last viewed record in the database file.    File records are sorted in descending
order from most recent to least recent by date, time, and description.

To clear the display, click the Clear button.



Find Record (Maintenance)

The Find Record ("I?I") button is used to locate a specific record without
having to "scroll" from record to record.    It is normally used to find records in
the middle of a database containing several records.

Clicking the Find Record ("I?I") button opens the Find Record window which
displays a list of budget descriptions in the sorted order of the database
file.    File records are sorted in descending order from most recent to least 
recent by date, time, and description.

To select a record, highlight the description of your choice and press the Continue
button.    The record is immediately displayed in the window.

To abort the search, click the Cancel button.    This will display the last record
of the database file.    Click the Clear button to clear the display.



Next Record (Maintenance)

Clicking the Next Record (">") button displays the next record from the last
viewed record in the database file.    File records are sorted in descending order 
from most recent to least recent by date, time, and description.

To clear the display, click the Clear button.



Last Record (Maintenance)

Clicking the Last Record (">I") button displays the last record of the database 
file.    File records are sorted in descending order from most recent to least 
recent by date, time, and description.

To clear the display, click the Clear button.



How To Register Your Program

As you exit Budget Planner for Windows, you will come to the Register BPW / Exit
window.    This window contains two buttons: Print Registration Form, and Exit.

Click the Print Registration Form button to open the Registration Form window.

Filling out the Registration Form
Printing the Registration Form



Filling out the Registration Form

To complete the Budget Planner for Windows Shareware Registration Form, fill in
the following fields:

      Name      Address      City      State      Zip Code      Number of Copies

Click the Totals button to generate the proper prices and the Print button
to print the form.



Printing the Registration Form

To print your Budget Planner for Windows Shareware Registration Form, click the
Print button.    A Windows Print box is displayed.    Select your printer and click
the Ok button.    To abort the print process, click the Cancel button.

Creating a printable ASCII file of the Registration Form



Creating a Print File

In addition to printing your database records and Shareware Registration Form,
you also have the option of saving your output as an ASCII "text" file.

To create a text file:

Be sure you have the Windows Generic / Text printer driver loaded in your 
Windows directory.

Be sure the driver is configured to File instead of an LPT port.

Select the Generic / Text driver when you wish to create a text file.

When you click the Ok button from the Print box a small window will appear
prompting you to enter a file name.    It is recommended that you use a .TXT
extension with your file name.    You may use a path along with your file name.

Click the Ok button from the file name box and the text file will be created.




